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Ce document est un manuel d'utilisation du prototype de programme 
d'ordinateur MacGRID, qui sert a generer des modeles a elements 
finis pour le code d'analyse MAVART. Comme son nom l'indique, 
MacGRID est congu pour tourner sur micro-ordinateur Macintosh 
d'Apple et peut utiliser tous les menus qui se retrouvent 
normalement dans une application Macintosh, en plus des menus 
speciaux necessaires pour generer un modele a elements finis. 
L'application comporte deux fenetres, la premiere montrant le 
modele sous forme graphique et permettant la creation et la 
manipulation du modele a l'aide d'une interface a souris. La 
seconde fenetre est une zone de texte servant a afficher et a 
modifier le fichier de donnees du modele selon les techniques 
normales d'edition 
Macintosh. 
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1. INTRODUCTION 

USER'S MANUAL FOR MacGRID 
Phase Ia 

GRID [1], a program for generating a finite element mesh forMA VART, was originally 
written for a DEC-20 computer and used a digitizing table for defining coordinate, connectivity and 
other data needed for the input data file. The Macintosh computer is an ideal platform to generate 
such a mesh, using only the devices that are normally available on any Macintosh. FanTech 
Consulting Service, under research contract No. W7707-4-3046/01-HAL (Phase Ia), has 
developed a working version of GRID for the Macintosh. MacGRID, the Macintosh version of 
GRID, is the subject of this Manual. 

MacGRID follows the Macintosh Human Interface Guidelines as much as possible, so, 
with the interface presented to the user, mesh generation is a simple, almost intuitive procedure. In 
this early version of MacGRID, there are a number of limitations that will be eliminated in future 
versions. These are discussed in Section 7. 

This Manual first describes briefly the present input data format required by MA V ART. 
Then the Windows, Dialogs, Palettes, and Menus that comprise the Macintosh user interface are 
described, along with instructions on how they are used to generate a new model or modify an 
existing model. Finally, some limitations of the present program and plans for future modification 
are discussed. 

2. MAVART INPUT DATA FORMAT 

The MA V ART input data file generated by MacGRID is an ASCII text file. It uses the 
same format that has been used historically. It consists of (1) a title line, (2) a problem ident­
ification line, (3) node lines, one for each node in the FE mesh, (4) material lines, (5) element 
lines, one for each element in the FE mesh, and (6) numerical data lines that prescribe some 
parameters of the analysis such as frequencies. Associated with a node line, there may be an extra 
line (3b) that prescribes non-zero fixities on the nodal degrees-of-freedom. Also, associated with 
the element line, there may be a 'POLANG' line (5b) that specifies certain element attributes, such as 
the symmetry angle of the material matrix. For details of the input data format, the reader is 
referred to the User's Manual for ProgramMA V ART [2]. 

MacGRID is primarily concerned with (3), (4), and (5); however, dummy lines (1) and (2) 
are generated for a new model and these may be edited in the text window. New material lines 
consist of the (negative) material number only, although full material matrices are retained for a 
model that is input from an existing data file. Fixity lines (3b) can only be inserted by editing the 
text window for a oomple.ted model. Provision is made for inserting ( 5b), a PO LANG value. Lines 
(6) can also be added by editing the text window. Lines (3b), (5b), and (6) are retained for a 
model that is input from an existing data file. 

3. WINDOWS 

Two windows are provided in MacGRID, a graphics window MacGRID Plot and a text 
window MacGRID TeHt, selectable via the Windows Menu, as described in Section 6. Most of 
the mesh generation for a model will take place in the graphics window, using Palettes to assign 
the required action. The Palettes are described in Section 5. Nodes, materials, and elements in the 
model are reflected in the text window, which displays the current MA V ART data file as it is being 
generated. 

1 
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An existing MA VART input data file can be read, using Open in the File Menu; the model 
is displayed in the graphics window and the data file is displayed in the text window. The title of 
the text window changes to that of the input data file. This model can then be changed by user 
action in the graphics window and these changes are again reflected in the text window. The input 
data file might represent a partially generated model that has been saved earlier, and the model 
generation is now being continued. 

The windows are full-screen in size, and are presently available only for the 13-inch colour 
monitor. The text window has a Close Box and a vertical Scroll Bar, while the graphics window 
has neither; however, both windows may be closed using Close in the File Menu. At start-up, 
both windows are opened and are devoid of data. The user may then begin model generation, or 
may read an existing data file and make modifications, or continue an interrupted model generation. 
After a new model is started, Open is disabled, so the user cannot inadvertently open an existing 
file. Also, after closing both windows, the only options available to the user are New or Quit in 
the File Menu. Selecting New opens both windows and initializes MacGRID the same as on 
start-up. The user must close both windows and select New before attempting to start generation 
of a new model. 

The graphics window cannot be saved as a document; it can however, be printed, using 
Print in the File menu). The text window can be saved or printed. On closing the text window 
or quitting MacGRID, the user is prompted as to whether a Save is desired. 

The text window is fully editable, with all items in the Edit menu operational except Undo. 
However, changes in the text are not reflected in the model displayed in the graphics window, so 
that any editing of nodal or element data should be done~ on a completed model. Alternatively, 
an edited data file for an unfinished model can be saved then re-opened by MacGRID, after closing 
both windows or quitting and restarting MacGRID. The edited changes will now be displayed in 
the graphics window and the model generation can continue. 

4. DIALOGS & ALERTS 

Several Dialogs and Alerts are invoked by user action in MacGRID, either when using 
certain Palette items, when selecting certain Menu items, or when clicking on a node or element. 
Dialogs request user input of data and are self-explanatory when displayed. In response to a 
Dialog, the user may click the 'Cancel' button, or the 'OK' button after ensuring that the 
requested data is correct. 

Alerts signal an inappropriate action, a warning, or instruction to the user and will specify 
such in a message. Generally, no action is available to the user except clicking the 'OK' button. 
The user should then comply with any instruction or take other appropriate action. 

The Dialogs and Alerts in MacGRID will be described in the following Sections in 
conjunction with the Menu or Palette action where they are invoked. 

2 
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5. PALETTES 

Six Palettes are included in the graphics window, three dealing with node action and three 
with element action. The node Palettes are Node Type, Node Action, and Coordinates. The 
element Palettes are Element Type, Element Action, and POLANG. For a new model, the 
first task is node generation, as no elements can be generated without nodes. Each of the Palettes 
is described below: 

a) Node Type Palette 
This Palette allows the selection of the desired type of node to be generated. The six node 
types used in MA V ART models are solid'S', piezoelectric 'A', fluid 'F', electric 'E', elastic 
shell 'H', and rigid 'R'. The default type is 'S '. A selected setting remains in effect until 
another is selected or until an element Palette item is chosen, when it reverts to the default. 

b) Node Action Palette 
The names displayed on the Palette buttons are self-explanatory, 'No Action', 'Create Node', 
'Delete Node', 'Move Node', 'Change Type', and 'Fixity ... '. The initial setting of this Palette 
is 'No Action'. The user should first select the type of node required, using theN ode Type 
Palette, if the default, 'S' is not the desired type. 
• 'Create Node' allows the creation of a node wherever the mouse button is clicked in the 
graphics region. This action may be modified by a selection in the Coordinates Palette, as 
described below. When 'Create Node' is selected to create the first node of a new model, the 
AHiS Scales ... Dialog is invoked, asking for user input of the minimum and maximum Z and 
R axis values. Initial values are 0.0 and 1.0 metre for each axis. This Dialog is also invoked 
by the Scales Menu, as described in Section 6. New nodes are always placed at the end of the 
node list in the data file, and if there are unused node numbers in the list, these are assigned 
first before higher node numbers are assigned. 
• 'Delete Node' causes any node that is selected by mouse clicking to be deleted. The arrow 
cursor must be within 5 pixels of an existing node if the node is to be selected; if not, an Alert 
is displayed informing the user that there is no node where the mouse was clicked. If the user 
attempts to delete a node that is used by an element, an Alert is displayed indicating that the 
delete action is rejected. 
• 'Move Node' allows the user to move a node by mouse action. Moving is accomplished 
by first clicking on the node you wish to move (within 5 pixels), then clicking on the point to 
which you want it moved; do not drag the node to the new position. 
• 'Change Type' and 'Fixity ... ' are not yet implemented. 

c) Coordinates Palette 
This Palette provides several different ways to set the coordinates of a node. Again, the labels 
displayed on the Palette buttons are self-explanatory, 'Choose Z', 'ChooseR', 'Choose Z&R', 
'Same Z&R', 'Same Z', 'Same R', 'Same Z as', 'Same R as', and 'As Clicked'. 
• 'As Clicked' is the default action, causing a node to be created at the location where the 
mouse button is clicked. 
• 'Choose Z' (or 'Choose R') invokes a Dialog requesting that the user type in a value for the 
appropriate coordinate. The other coordinate is set by the position where the mouse button is 
clicked. 
• 'Choose Z&R' is not implemented at present. 
• 'Same Z&R' invokes an Alert asking the user to click on the node with the required 
coordinates. This action procedure remains in effect until some other palette item is chosen. 
• 'Same Z' (or 'Same R') causes a node to be created with the same Z (orR) coordinate as 
the previously created node, the other coordinate being set by the position where the mouse 
button is clicked. This allows a series of nodes to be created along a horizontal (or vertical) 
line. 

3 
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• 'Same Z as' (or 'Same R as') waits for the user to click the mouse button at some location 
in the window, then invokes an Alert asking that the desired reference node be identified by 
clicking on it. The location of the original mouse click sets the other coordinate. 

d) Element Type Palette 
This Palette allows the user to select any of the 16 types of element used by MA VART. Types 
1 to 4 are triangular elements, Types 12 to 1 S are quadrilateral elements, and Types S to 1 0, 
and 16 are line elements. Type 11 is a one-noded RING element. The default type is 1, a 
SOUD triangle. Element Types 9 and 11 are not yet supported by MacGRID. 

e) Element Action Palette 
This Palette selects user action relating to elements. The default is 'No Action'. 
• 'Create' allows the user to create an element by mouse action. New elements are placed at 
the end of the element list in the data file, and if there are unused element numbers in the list, 
these are assigned first before higher element numbers are assigned.. The desired element type 
is first selected using the Element Type Palette, if the default, '1' is not the desired type. 
Appropriate corner or end nodes must exist before an element can be created. The user clicks 
on the two end nodes for a line element, the three comer nodes for a triangular element, and the 
four comer nodes for a quadrilateral element. The other required nodes of the element are then 
automatically created if they do not already exist. To create a FrOS element, solid and fluid end 
nodes must exist with the same coordinates. If a node is selected that is of the wrong type for 
the current element, an Alert is displayed informing the user of the error. 'S', 'H', or 'A' 
nodes are accepted for a SOUD, SOUDQ, or FfOS element. If there is no node within 5 pixels 
of the mouse click, a "No node" Alert is displayed. This Alert is also displayed when creating 
a FfOS element, if 1wQ nodes of the proper types do not exist at the end positions. If a node is 
selected that is not a comer or end node of an element, and not an unattached node, an Alert is 
displayed informing the user of the inappropriate selection. 
• 'Delete' allows the user to delete an element by clicking on it. For a line element, the click 
must be within 5 pixels of the centre node; for an areal element, the click must be at least 5 
pixels inside the element boundary. Otherwise, an Alert is displayed informing the user that no 
element exists where the mouse was clicked. When an element is being deleted, all nodes of 
that element that are not used by another element are also deleted. 
• 'Material' allows selection of a material number for the element being created. A Dialog is 
invoked asking the user to type in a material number. The default value is 1; zero must not be 
used and the maximum value accepted by MA V ART is 30. If the first element on a new model 
is being created, the Material Dialog is displayed automatically. For each material selection, 
only a single material line, with the negative of the material number, is placed in the data file. 
This instructs MA V ART to look for the material properties on a separate materials file, which is 
generated by program MATER. New materials are placed at the end of the materials list. 

f) POLANG Palette 
This Palette allows selection of a POLANG value for the element being created. The default 
value is zero. The commonly used values, :rt, :rt/2, and 3:rt/2 can be selected on the Palette. 
Other values are specified by selecting'? ... ', which invokes a Dialog asking the user to type in 
the desired value. The latter item (? ... ) is not yet implemented. 

I 6. MENUS 

The MacGRID menu bar includes the standard Macintosh menus, tt, File, and Edit, 
which contain the usual items and will not be described here. In addition, there are four special 
menus, Nodes, Elements, Scales, and Windows. Each of these is described below: 

4 
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a) Nodes Menu 
The Nodes menu deals with display and creation of nodes and contains three items. The first 
item, Reorder has not yet been implemented. The second item causes the display or non­
display of node numbers on the plot, toggling between Show Numbers and Hide 
Numbers. The third item NodesOnRadius ... invokes a dialog asking for user input of (1) 
the Z and R coordinates of the centre of the arc on which new nodes are to be created, (2) the 
radius of the arc, and (3) the number of nodes to be created. At present, the Z and R 
coordinate input is not implemented and the values are fixed at zero, i.e., the centre of the arc is 
the origin and the arc angle is 90° between the positive Z and R axes. If NodesOnRadius ... 
is used to create the first nodes of a new model, the AHiS Scales ... Dialog is invoked, asking 
for user input of the minimum and maximum Z and R axis values. 

b) Elements Menu 
The Elements menu contains three items dealing with creation, modification, and display of 
elements. The first item, AbortCreate allows the user to abort the creation of a new element 
for any reason, such as clicking on the wrong node or selecting the wrong material. An Alert 
is displayed, instructing the user to start over again choosing the nodes. Of course, this menu 
item must be chosen before clicking the final node; otherwise the bad element must be deleted. 
The second item Show/Hide Numbers is the same as in the Nodes Menu, except that 
element numbers are displayed or not displayed. The third item Straighten moves all nodes 
so that the mid-nodes on the sides of each element are centred between the comer or end nodes; 
centre nodes on quadrilateral elements are placed at the element centroid. Ruid-to-fluid mid­
nodes are not affected. 

c) Scales Menu 
The Scales menu contains three items that allow the user complete flexibility in setting the axis 
scales of the graphic display. The first item, Select Region activates a mouse dragging 
routine to allow the user to drag a dotted rectangle over the region of the plot that is to be 
expanded to fill the window. The second item, AHiS Scales ... invokes a dialog that asks for 
user input of the minimum and maximum Z and R axis values, allowing the user to choose any 
desired scale. The third item, Full Scale reverts to the original values of axis scales after a 
new region has been chosen by Select Region. If AHiS Scales ... has been used to select the 
region, Full Scale has no effect. 

d) Windows Menu 
The Windows menu contains only two items, allowing selection of either of the two 
windows, MacGRID Plot or MacGRID TeHt. The currently selected menu item is marked by 
a check mark (v'). The Nodes, Elements, and Scales menus are disabled when the text 
window is selected. 

7. LIMITATIONS OF VERSION 0.5 

1. End nodes must now be clicked to create a FTOS element. In future versions, FTOS elements 
will be generated automatically when contiguous FLUID and solid elements are created. 

2. If the user mistakenly chooses the wrong nodes in creating an areal element, an element with 
no area can be created. It is then impossible to delete the bad element by mouse clicking. 
The user must then remove the element by editing the text window, saving, and closing both 
windows. The saved file can then be read in by MacGRID and model generation can 
continue. In future, an item will be added to the Elements Menu, invoking a Dialog that 
allows the user to type in the bad element number for deletion. 

5 
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3. The largest file that can be displayed in the Text Window at present is 32767 characters. This 
is only about 30% that of a full-size MA V ART model and will be extended in future 
versions. 

4. When an element is deleted, all nodes in that element are also deleted, unless they are used by 
another element. In future versions, the user will have the options of retaining or deleting the 
nodes. At present, before deleting an element, the user should create a new node or nodes at 
the location(s) where they are needed, using the 'Same Z&R' Palette item. 

5. The NodesOnRadius Dialog is now limited to 90° arcs centred at the origin. A more versatile 
Dialog will be set up in future versions. 

6. Element types 9 (SUDER) and 11 (RING), which are not yet supported, will be supported in 
future versions. 

7. Although MA VART no longer uses column 35 (JFIX), MacGRID requires this number for 
reading existing files. This can be changed for future versions, as some existing data files 
will not be read properly. 

8. Some dialogs that are presented to the user do not behave properly when the Cancel button is 
clicked. If new data was input before the cancel action, the old data may not have been 
restored. The code causing this has been identified; by the time this manual is published, the 
problem may be eliminated. 
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